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Overview
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Create your own wireless Bluetooth keyboard controller in an hour with the Bluefruit EZ-
Key: it's the fastest, easiest and bestest Bluetooth controller. We spent years learning how
to develop our own custom Bluetooth firmware, and coupled with our own BT module
hardware, we've created the most Maker-friendly wireless you can get!

This breakout acts just like a BT keyboard, and works great with any BT-capable device:
Mac, Windows, Linux, iOS, and Android. Power the module with 3-16VDC, and pair it to the
computer, tablet or phone just as you would any other BT device. Now you can connect
buttons from the 12 input pins, when a button is pressed, it sends a keypress to the
computer. We pre-program the module to send the 4 arrow keys, return, space, 'w', 'a', 's',
'd", "1" and '2' by default. Advanced users can reprogram the module's keys using an FTDI

or other Serial console cable, for any HID key report they desire.

https://learn.adafruit.com/introducing-bluefruit-ez-key-diy-bluetooth-
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You can pair multiple Bluefruit's to a single device, each one has a unique identifier. These
modules are FCC & CE certified and are RoHS-compliant so they are easy to integrate into
your project.

If you want to have better control over the data sent, connect a microcontroller to the RX
pin at 3-5V logic level, 9600 baud, and send ASCII data: it will be 'typed out' character by
character. We also have support for various non-printable characters such as ESC, Shift,
F1-F12, etc. as well as toggling the virtual keyboard on iOS.

New in v1.1 (shipping as of Oct 22 2013) - We've made Bluefruit EZ-Key even better, you
can now map keys to mouse button clicks and mouse movement (up/down/left/right) as well
as send mouse commands over the UART. We also now have 'over the air' remapping, no
serial cable required to re-map the pins!

New in v1.2 (shipping as of Nov 7 2013) - We have added support for mapping buttons to
some "Consumer Report" keys, also known as Multimedia buttons.
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Pinouts
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This is a tour of all the pins available on the EZ-Key module. The module consists of a CSR
BlueCore with custom firmware on a breakout PCB. The PCB makes it easy to use and
hard to break. Every pin and connection you want is available on the breakout board, and
there's even some handy mounting holes.

Palr

Let's take a tour of the pins! Starting with the top control & power pins...

Top Row

Grounds and Vin

To use this module, you will need to at least power it. Powering it is easy though, you can
give it anywhere between 3-16VDC and the power input is reverse-polarity protected.
Connect the positive wire from your battery to Vin and ground to the Grounds or G pin.
There is an output from the onboard 3.3V voltage regulator on pin 3v that will let you snag
~100mA of current for other sensors, microcontrollers or whatever.

https://learn.adafruit.com/introducing-bluefruit-ez-key-diy-bluetooth-
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Control and LEDs

To the right of the power pins, there are some control pins

¢ RS - this is the reset pin. To reset the module, pull this pin to ground. It does not
affect pairing.

e L2 -thisis the same output that is connected to thePair LED. If you want to put this
in a box and have an external Pair indicator LED, wire an LED from this pin, through a
1K resistor, to ground.

e PB - this is the pair button pin. It is connected to the button onboard that is used to
reset the pairing. If you want to make another, external pair button, connect a switch
from this key to 3V (not ground!)

e L1 -this is the same output that is connected to theKey LED. If you want to put this
in a box and have an external Key-press indicator LED, wire an LED from this pin,
through a 1K resistor, to ground.

o RX - this is the UART input, used if you want to send UART->Keypress data, or re-
map the buttons. It is 5V compliant, use 3V-5V TTL logic, 9600 baud.

e TX- this is the UART output, used for watching debug data or re-mapping the
buttons. It is 3V logic level output.

Bottom Row

This row is easy, it is 12 individual pins that connect to a switch that will trigger a keypress.
Each pin has a pullup resistor internally to 3V. To activate a keypress, connect the pin to
ground. When it is connect to ground, a KEYDOWN is sent, when it is disconnected, a
KEYUP is sent.

Do not inject 5V into these pins! They connect directly to the BT module which runs at 3V.

Left Port (6-pins)

Despite looking a /ot like an FTDI connector, this is the programming/test port. We use this
at the Adafruit factory to get your modules tested. It is not field reprogrammable. Do not
connect anything to these pins, it could damage or permanently brick the EZ-Key!

https://learn.adafruit.com/introducing-bluefruit-ez-key-diy-bluetooth-
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Pairing to Bluefruit

Before you can use the EZ-Key you have to pair it to your computer, laptop, tablet or
phone. It's pretty easy to do this because EZ-Key acts just like a Bluetooth keyboard.

We have detailed walkthroughs for Windows, Mac and Linux (Raspberry Pi)

We have also paired it without difficulty to iOS devices such as iPhone and iPad (any
version) and an Android tablet but don't have a detailed walkthrough. Check your device's
documentation on how to pair a keyboard. It's usually really easy and just requires turning
on BT and then scanning for the powered up module.

You only have to pair once to your device. After that, it will auto-connect.
If you ever have difficulties with auto-connecting, especially if you do a system update or

upgrade, just follow the pairing procedure from the beginning. It only takes a few minutes.
The following GIF shows meaning of the red LED on board.

Mot paired. Discoverable

Trying connecting host

https://learn.adafruit.com/introducing-bluefruit-ez-key-diy-bluetooth- Page 8 of 60
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Windows

This page will show you how to pair your Bluefruit EZ-Key to a Windows computer. It's
tested on XP and 7 but should work similarly with Windows 8.

You only have to pair once - after the EZ-Key is paired to a computer it will auto-
connect from then on

First up, you'll have to make sure you have Bluetooth v2.1 or greater on your computer.
Many laptops have BT built in and unless its a really old machine (< 2008), the built in BT
should be OK. If you do not have BT built in, you'll need a USB dongle such as this

one (http://adafru.it/1327)

Many ultra-low cost USB adapters you may find are BT v2.0 and NOT v2.1. You MUST
have a v2.1 or greater adapter, as v2.0 does not support the way we handle pairing. If you
get a BT v4 module you will have no problems, so please do not use "$2" adapters!

https://learn.adafruit.com/introducing-bluefruit-ez-key-diy-bluetooth-
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Step 0. Install USB adapter

99% of the time, you can just plug it in and Windows will automatically install the drivers, as
there are only two main chipsets (CSR & Broadcom) and they have built in support.

Step 1. Power the Bluefruit EZ-Key and
Press the Pair Button

The title of this step is pretty much what you have to do. Remember that you have solder
the 0.1" headers to the module or at least solder wires to the Vin and Ground connections.
Connect Vin to 3 to 16VDC (5V is ideal) and ground to the ground power wire.
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You should see the red LED blink. Now press the mini button on the EZ Keyfor 5
seconds and release, this will erase any old pairing information and let you re-pair to your
computer.

The red LED will now blink at a steady once-a-second.

Step 2 Pair using Windows Bluetooth
services

https://learn.adafruit.com/introducing-bluefruit-ez-key-diy-bluetooth-
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In the Control Panel, find the Add Bluetooth Device entry

s, =
~ )= |®3 » Cont.. » Hardware and... » ¥ | #4 | | bluetooth *
€1oM [4]] |

Control Panel Home c c
/ Devices and Printers

qgli 2 J [ ViC

System and Security I Add a Bluetooth I:|E.I-_i.E
Change Bluetooth settings

Network and Internet View devices and printers

Hardware and Sound

LA Network and Sharing Center

Programs .‘* Set up a connection or network
User Accounts and Family
Safety @Search Windows Help and Support for "bluetooth”

Appearance and
Personalization

Clock, Language, and Region

Ease of Access I|

Wait a minute until you see the Adafruit Keyboard device show up with the full ID name, it
will look like this:

https://learn.adafruit.com/introducing-bluefruit-ez-key-diy-bluetooth-
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Select a device to add to this computer

Windows will continue to look for new devices and display them here,

 brian's MacBook Air Adafruit EZ-Key 0482

Bluetocoth . Bluetooth
3 Laptop computer — Keyboard

What if Windows doesn't find mv device?

et (]

b —

Select the Adafruit EZ-Key and press Next

https://learn.adafruit.com/introducing-bluefruit-ez-key-diy-bluetooth-
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Connecting with this device

Ensure that this is the device you want to add to your computer,

Adafruit EZ-Key 0482

(_} Adding device...

It may take up to 3 minutes to get the driver and install it, this is normal. If Windows
complains about a timeout, just start the process over (it's rare for that to happen)

If it asks you for a passcode, the pairing code is1234

https://learn.adafruit.com/introducing-bluefruit-ez-key-diy-bluetooth-
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This device has been successfully added to this computer

Windows is now checking for drivers and will install them if
necessary. You may need to wait for this to finish before your device
is ready to use.

To verify if this device finished installing properly, look for it in
Devices and Printers.

Adafruit EZ-Key 0482

E

" Bluetooth HID Device A X

=% Device driver software installed successfully.

That's it! You will now see the red LED blinking much slower, to indicate it is paired
succesfully

https://learn.adafruit.com/introducing-bluefruit-ez-key-diy-bluetooth-
hid-keyboard
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Mac

This page will show you how to pair your Bluefruit EZ-Key to a Mac OS X computer.
Connecting to iOS is nearly identical.

You only have to pair once - after the EZ-Key is paired to a computer it will auto-
connect from then on

We have never found a Mac without BT built in so lucky for you, no extra module is
required! (http://adafru.it/1327)

Step 1. Power the Bluefruit EZ-Key and
Press the Pair Button

The title of this step is pretty much what you have to do. Remember that you have solder
the 0.1" headers to the module or at least solder wires to the Vin and Ground connections.
Connect Vin to 3to 16VDC (5V is ideal) and ground to the ground power wire.
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You should see the red LED blink. Now press the mini button on the EZ Keyfor 5
seconds and release, this will erase any old pairing information and let you re-pair to your
computer.

https://learn.adafruit.com/introducing-bluefruit-ez-key-diy-bluetooth-
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The red LED will now blink at a steady once-a-second.

Step 2. Pair Using MacOS Bluetooth
Service

In the System Preferences, find the Bluetooth icon

80o System Preferences
[«/> ][ Showan | (Q J
Personal
B | )
o @ ¢ @ B
- & M B @ o
Ceneral Desktop & Dock Mission Language Security Spotlight Motifications
Screen Saver Control & Text & Privacy
Hardware
S = O
>, " S — 9
CDs & DVDs Displays Energy Mouse Trackpad Print & Scan Sound
Saver

Internet & Wireless

a4 @ & 0 @

iCloud Mail, Contacts  Metwork Eluetooth Sharing
& Calendars
System
gu) m . ™
R » & @ ¢ @ :
Users & Parental Date & Time Software Dictation  Time Machine Accessibility Startup Disk
Groups Controls Update & Speech
Other

O w B €& =

Blackmagic Cinefarm Flash Player Cantrol Center Perian
Design

Double-click to open, make sure Bluetooth is ON (some computers have it off, you must
have BT on!) and click Set Up New Device

https://learn.adafruit.com/introducing-bluefruit-ez-key-diy-bluetooth-
hid-keyboard
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anon Bluetooth

| — ;

“pt" is the name Bluetooth devices use to connect to this computer.

™ On | Discoverable

No Devices

[ Set Up New Device... |

|| Show Bluetooth in menu bar | Sharing Setup... | | Advanced... | @

Let the assistant run for a minute until it locates and displays the EZ-Key module
Select it and click Continue

https://learn.adafruit.com/introducing-bluefruit-ez-key-diy-bluetooth-
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800

sBlustacthSelupgssistant

Welcome to the Bluetooth Setup Assistant.

When your device appears in the list, select it and click Continue, If you
don't see your device in the list, make sure it is powered on and
“discoverable.” For more information, see the documentation that
came with your device.

Devices

Type

Adafruit EZ-Key 0482

Keyboard

EDIFIER Spinnaker HiFi

3 Updating 1 device name...

It'll take a minute for it to pair

800

Bluetooth,Setup, Assistant

Attempting to pair with “Adafruit EZ-Key 0482."

A la
ne
Connecting to “Adafruit EZ-Key 0482.7

© Adafruit Industries https://Iearn.adafrur[.com/lntr.odumng-bluefrwt-ez-key-dly-bluetooth- Page 18 of 60
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That's it! If you get a pop-up asking you to configure the keyboard layout, just close or quit
that window.

800 sbluetaoih;SeipLRssistant

Conclusion
Congratulations! Your computer is now set up to use your keyboard.

| Set Up Another Device | E

You can now see that the EZ-Key is paired and connected.

https://learn.adafruit.com/introducing-bluefruit-ez-key-diy-bluetooth-
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8eo0o Bluetooth

“pt" is the name Bluetooth devices use to connect to this computer.

™ On | Discoverable

afruit EZ- Name Adafruit EZ-Key 0482
onnected Type Keyboard
Display Mame Adafruit EZ-Key 0482
Services CSR Keyboard
Paired ¥ Yes
Connected @ Yes

[ [# ]

|| Show Bluetooth in menu bar [ Sharing Setup... ] [ Advanced... ] @

© Adafruit Industries https://learn.adafruit.com/introducing-bluefruit-ez-key-diy-bluetooth-
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Linux (e.g. Raspberry Pi)

This page will show you how to pair your Bluefruit EZ-Key to a Linux computer. It's tested
on Raspberry Pi & Raspbian but the instructions will be similar for other machines and
distros (we hope!) Check your distro documentation if this doesn't work.

Thanks to http.://www.correlatedcontent.com/blog/bluetooth-keyboard-on-the-raspberry-
pi/ (hitp://adafru.it/cJW) for the details!

You only have to pair once - after the EZ-Key is paired to a computer it will auto-
connect from then on

First up, you'll have to make sure you have Bluetooth v2.1 or greater on your computer.
Many laptops have BT built in and unless its a really old machine (< 2008), the built in BT
should be OK. If you do not have BT built in, you'll need a USB dongle such as this

one (http://adafru.it/1327)

https://learn.adafruit.com/introducing-bluefruit-ez-key-diy-bluetooth-
hid-keyboard
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Many ultra-low cost USB adapters you may find are BT v2.0 and NOT v2.1. You MUST
have a v2.1 or greater adapter, as v2.0 does not support the way we handle pairing. If you
get a BT v4 module you will have no problems, so please do not use "$2" adapters!

Step 0 Plug in BT Adapter

With the Raspberry Pi off, plug in the BT module and reboot.

Step 1 Update & Install Bluez

Make sure you have Internet connectivity on your Pi so you can install the following
updates & software for Bluetooth control.

All of the following must be typed into a Terminal window or Console or Command line.

https://learn.adafruit.com/introducing-bluefruit-ez-key-diy-bluetooth-
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sudo apt-get update
sudo update

f dous defaults

rc.d

sudo apt-get install bluez python-gobject
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pi
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defaults
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Now run

hcitool dev

to see the bluetooth USB module

Lastly, we'll make a minor edit to allow passkey-less pairing. Run
sudo nano /ust/bin/bluez-simple-agent

To edit the agent that manages BT pairing. Type Control-W to search for
K_(_eyboardDispIay

GHU nano 2.2.6 File: fusr/bin/bluez-simple-agent -

B T T Toorep St R |
VA1LCE . IRET a i

salf,

Then edit that line and change KeyoardDisplay to DisplayYesNo

https://learn.adafruit.com/introducing-bluefruit-ez-key-diy-bluetooth-
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I/l GHU nmano 2.2.6 File: fuszr/bin/bluez-simple-agent Modified

Step 2. Power the Bluefruit EZ-Key and
Press the Pair Button

The title of this step is pretty much what you have to do. Remember that you have solder
the 0.1" headers to the module or at least solder wires to the Vin and Ground connections.
Connect Vin to 3to 16VDC (5V is ideal) and ground to the ground power wire.

https://learn.adafruit.com/introducing-bluefruit-ez-key-diy-bluetooth-
hid-keyboard
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You should see the red LED blink. Now press the mini button on the EZ Keyfor 5
seconds and release, this will erase any old pairing information and let you re-pair to your
computer.

The red LED will now blink at a steady once-a-second.

Step 3. Scan & Connect to Bluefruit
Module

Now it's time to find the Bluefruit device. Run
hcitool scan

to scan for devices. You may have to run it once or twice to see the Adafruit device pop up
¥ pi@raspberrypi: ~ Ll_lﬁnﬂ E.

__________

https://learn.adafruit.com/introducing-bluefruit-ez-key-diy-bluetooth-
hid-keyboard
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See that long number before the name? Starts with 00:18:... ? Each module has a unique
identifier number. Your setup will have a different ID so be sure to type out the exact same
ID you have. We will proceed as if you were pairing to the module on my desk :)

We will now create a device for the keyboard. Type in
sudo bluez-simple-agent hci0 00:18:96:B0:04:82

But changing it to the ID number you have
@ pi@raspberrypi: ~

ext, we will frust this keyboard. Type in
sudo bluez-test-device trusted 00:18:96:B0:04:82 yes

(don't forget that yes at the end)
followed by

sudo bluez-test-device trusted 00:18:96:B0:04:82

(no yes at the end)
You should see a1 after the last command. If you get a0 try again, check that you typed
the #'s right.

@pi@ra spbermypi: ~

Finally, we can connect! The last command to run is:

sudo bluez-test-input connect 00:18:96:B0:04:82

https://learn.adafruit.com/introducing-bluefruit-ez-key-diy-bluetooth-
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If you want to ever remove the pairing, type in

sudo bluez-test-device remove 00:18:96:B0:04:82

Now you will notice the red LED on the module blink slower.

pi@raspberrypi: ~

| ” |_ az-Taat- S : : |
REMEMBER! This is a USB keyboard so if you are SSH'd or connecting via a Console
cable, you WON'T see keystrokes appear. On a Raspberry Pi you have to connecta TV to
the Composite or HDMI outputs to see the keyboard input.

© Adafruit Industries https://Ieam.adafrU|t.com/|ntrodumng—bluefrun—ez—key—d|y—bIuetooth— Page 28 of 60
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User Manual

1 AmAA Battery
[ |

1- Aianeqg vyy |"||

|| AAA Battery -I
T

The user manual is the shortest page of this guide, because its really really easyto get
going.

1. Power the EZ-Key with 3-16VDC power. Batteries work great: 3 or 4 alkaline or

rechargeable 1.5V, a 9V, Lithium lon/Polymer, Lead acid... Whatever you have!

Pair the EZ-Key to your computer, laptop, tablet or phone

3. Connect one side of a switch to GPIO #0 through #11. Connect the other side to
Ground.

4. Open up a notepad or text editor on the paired computer

5. Press the switch to send a key code

6. Profit?

n

You will be able to see the green LED blink every time it detects a switch and sends the
keycode.

Since GPIO #0 through #3 are arrow keys, they might be more difficult to detect if the
notepad software is empty. Try GPIO #4 through #11 which send printable characters

When a switch is pressed, a KEYDOWN command is sent, when it is release, a matching
KEYUP goes out. You can have up to 6 switches pressed at once and it will be like they
were pressed all at the same time. 6 is a strict limit of Bluetooth.

Don't forget: You don't have to use a plain clicky switch! Try tilt sensors, reed
switches, conductive velcro, big stompy buttons, arcade joysticks, ANYTHING that

https://learn.adafruit.com/introducing-bluefruit-ez-key-diy-bluetooth-
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makes/breaks two contacts

Here is the default switch-to-key mapping:

e #0 - Up Arrow

e #1 - Down Arrow
o #2 - Left Arrow

e #3 - Right Arrow

e #4 - Return

e #5 - Space

e #6 - the number '1'
e #7 - the number '2'
e #8 - lowercase 'W'
e #9 - lowercase 'a'
e #10 - lowercase 's'
e #11 - lowercase 'd'

You can customize these with a little bit of effort, see the Remapping Buttons page.

Dimensions in Inches & mm

https://learn.adafruit.com/introducing-bluefruit-ez-key-diy-bluetooth-
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Sending Keys/Mouse Via Serial

For advanced users, you may want to hook up your Bluefruit to a microcontroller and send
characters or strings via Bluetooth.

You can do this with the UART port on the EZ-Key. The UART pins are labeled RX (data
going into the module) and TX (debug data coming out of the module). You can get away
with just connecting to RX. The RX pin is 5V compliant, you can send it 3V or 5V TTL logic
levels. Use 9600 baud serial, all microcontrollers will support this.

You can also send raw HID Keyboard reports for complex key-stroke combinations and
controls.

In version v1.1 (Oct 22, 2013 or later)HID Mouse reports are also supported, you can
send mouse movement and clicks via the UART and microcontroller

In version v1.2 (Nov 2013 or later) HID consumer report keys are supported, there are a
few supported 'multimedia keys' - see below for a list and how to send via the UART

Don't forget to also tie a ground pin from your microcontroller to the EZ-Key for the logic
ground reference!

Printable character keymap

For printing ASCII characters, you can simply send those to the UART and they will be
'typed out'. See below for the list of printable ASCII characters, starting with 0x20 and
ending with Ox7E

Thanks to Wikipedia for this nice chart!(http://adafru.it/cJX)
Binary Oct Dec Hex Glyph

010 0000 04032 20

010 0001 041 33 21 |

010001004234 22 "

010001104335 23 #

010010004436 24 $

010010104537 25 %
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http://en.wikipedia.org/wiki/ASCII_chart

010 0110 046 38
010 0111 047 39
010 1000 050 40
010 1001 051 41
010 1010 052 42
010 1011 053 43
010 1100 054 44
010 1101 055 45
010 1110 056 46
010 1111 057 47
011 0000 060 48
011 0001 061 49
011 0010 062 50
011 0011 063 51
011 0100 064 52
011 0101 065 53
011 0110 066 54
011 0111 067 55
0111000 070 56
0111001 071 57
0111010 072 58
0111011 073 59
0111100 074 60
0111101 075 61
0111110 076 62
0111111 077 63

26 &
27 '
28 (
29 )
2A ~
2B +
2C
2D -
2E
2F
30
31
32
33
34
35
36
37
38
39
3A
3B ;
3C <
3D =
3E >
3F ?

© 00O NOoO ok WOWN 2 O ™ -

Binary Oct Dec Hex Glyph

100 0000 100 64
100 0001 101 65
100 0010 102 66
100 0011 103 67
100 0100 104 68
100 0101 105 69
100 0110 106 70
1000111 107 71

© Adafruit Industries

40
41
42
43
44
45
46
47
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100 1000 11072 48
100 1001 11173 49
100 101011274 4A
100 1011 11375 4B
100 1100 11476 4C
100 1101 11577 4D
100111011678 4E
100 111111779 4F
101 0000 120 80 50
101 0001 121 81 51
101 0010 12282 52
101 0011 12383 53
101 0100 124 84 54
101 0101 12585 55
101 0110 126 86 56
101 011112787 57
101 1000 130 88 58
101 1001 13189 59
101101013290 5A
101 1011 13391 5B
101 1100 13492 5C
101 1101 13593 5D
1011110136 94 5E
101 111113795 5F _
Binary Oct Dec Hex Glyph
110 0000 14096 60 °
110 0001 141 97 61
110 0010 14298 62
110 0011 14399 63
110 0100 144 100 64
110 0101 145 101 65
1100110 146 102 66
1100111 147 103 67
110 1000 150 104 68
110 1001 151 105 69

>— “ T N<X<Xs<CHmwWIOUVOZZTrXG<—T

SQ " 0 O O T 9o
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110 1010 152 106 6A
1101011 153 107 6B
110 1100 154 108 6C
110 1101 155 109 6D
1101110156 110 6E
110 1111 157 111 6F
111 0000 160 112 70
111 0001 161 113 71
111 0010162 114 72
111 0011 163 115 73
111 0100 164 116 74
111 0101 165117 75
111 0110 166 118 76
111 0111 167 119 77
111 1000 170 120 78
1111001 171 121 79
1111010172 122 7A
1111011173 123 7B
1111100174 124 7C
1111101175125 7D
1111110176 126 7E

— x —

~ 0 T 0o 5 3

-+ w

!~ — ~ N < X s < c

Non-printable Characters

There's a lot of other keycodes you may want to send, here is the mapping from the 8-bit
byte to the keycode sent.

HEX Keyname
0x01 Insert
0x02 Home
0x03 Page Up
0x04 Delete
0x05 End
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865 RAAR Rs

0x08 Backspace
0x09 Tab
O0x0A Enter
0x0B Left Arrow
0x0C Down Arrow
0x0D Enter
Ox0E Up Arrow
OxOF -
0x1A F1-F12
0x1B Esc
0x1C Caps Lock
0x1D Scroll Lock
Ox1E Break
Ox1F Num Lock
0x20-0x7E Printable Ascii
Toggle iOS
Ox7F Ke?/goard
OxEO Left Control
OxE1 Left Shift
OxE2 Left Alt
OxE3 Left GUI
OxE4 Right Control
OxE5 Right Shift
OxE6 Right Alt
OxE7 Right GUI

Raw HID Keyboard Reports

Bluefruit can send raw HID Keyboard reports. This allows sending any modifier keys + up to
6 keycodes at once. Its advanced but super useful for when you want to have fine-control
of keypresses!

Raw HID reports start with 0xFD and have 8 bytes following. For keyboard, its
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0xFD [modifiers] 0x00 [keycode1] [keycode2] [keycode3] [keycode4] [keycode5]

[keycode6]
Raw USB HID keycodes are not the same as ASCII!

Here's a list of USB HID keycodes (its in java format but you get the idea), you can also get

another list here

http://www.freebsddiary.org/APC/usb_hid_usages.php (http://adafru.it/cQV) under "7

Keyboard"

/I Bits in usbHidKeyboardInput.modifiers

final byte MODIFIER_NONE =byte((0));

final byte MODIFIER_CONTROL_LEFT =byte((1<<0));
final byte MODIFIER_SHIFT_LEFT =byte((1<<1));
final byte MODIFIER_ALT_LEFT  =byte((1<<2));

final byte MODIFIER_GUI_LEFT  =byte((1<<3));

final byte MODIFIER_CONTROL_RIGHT =byte((1<<4));
final byte MODIFIER_SHIFT_RIGHT =byte((1<<5));
final byte MODIFIER_ALT_RIGHT  =byte((1<<6));
final byte MODIFIER_GUI_RIGHT  =byte((1<<7));

// Values for usbHidKeyboardInput.keyCodes
// Only the key codes for common keys are defined here. See Hut1_12.pdf for a full list.

final byte KEY_NONE =byte(0x00);
final byte KEY_A =byte(0x04);
final byte KEY_B =byte(0x05);
final byte KEY_C =byte(0x06);
final byte KEY_D =byte(0x07);
final byte KEY_E =byte(0x08);
final byte KEY_F =byte(0x09);
final byte KEY_G =byte(0x0A);
final byte KEY_H =byte(0x0B);
final byte KEY_| =byte(0x0C);
final byte KEY_J =byte(0x0D);
final byte KEY_K =byte(0x0E);
final byte KEY_L =byte(0x0F);
final byte KEY_M =byte(0x10);
final byte KEY_N =byte(0x11);
final byte KEY_O =byte(0x12);
final byte KEY_P =byte(0x13);
final byte KEY_Q =byte(0x14);
final byte KEY_R =byte(0x15);
final byte KEY_S =byte(0x16);
final byte KEY_T =byte(0x17);
final byte KEY_U =byte(0x18);
final byte KEY_V =byte(0x19);
final byte KEY_W =byte(0x1A);
final byte KEY_X =byte(0x1B);
final byte KEY_Y =byte(0x1C);
final byte KEY_Z =byte(0x1D);
final byte KEY_1 =byte(0x1E);
final byte KEY_2 =byte(0x1F);

© Adafruit Industries
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final byte KEY_3
final byte KEY_4
final byte KEY_5
final byte KEY_6
final byte KEY_7
final byte KEY_8
final byte KEY_9
final byte KEY_O

final byte KEY_RETURN
final byte KEY_ESCAPE
final byte KEY_BACKSPACE

final byte KEY_TAB

final byte KEY_SPACE
final byte KEY_MINUS
final byte KEY_EQUAL
final byte KEY_BRACKET_LEFT
final byte KEY_BRACKET_RIGHT
final byte KEY_BACKSLASH
final byte KEY_EUROPE_1
final byte KEY_SEMICOLON
final byte KEY_APOSTROPHE
final byte KEY_GRAVE

final byte KEY_COMMA

final byte KEY_PERIOD

final byte KEY_SLASH

final byte KEY_CAPS_LOCK

final byte KEY_F1
final byte KEY_F2
final byte KEY_F3
final byte KEY_F4
final byte KEY_F5
final byte KEY_F6
final byte KEY_F7
final byte KEY_F8
final byte KEY_F9
final byte KEY_F10
final byte KEY_F11
final byte KEY_F12

final byte KEY_PRINT_SCREEN
final byte KEY_SCROLL_LOCK
final byte KEY_PAUSE
final byte KEY_INSERT
final byte KEY_HOME
final byte KEY_PAGE_UP
final byte KEY_DELETE

final byte KEY_END

final byte KEY_PAGE_DOWN
final byte KEY_ARROW_RIGHT
final byte KEY_ARROW_LEFT
final byte KEY_ARROW_DOWN
final byte KEY_ARROW_UP

© Adafruit Industries

=byte(0x27);

=byte(0x28);
=byte(0x29);
=byte(0x2A);

=byte(0x2B);

=byte(0x2C);
=byte(0x2D);
=byte(0x2E);
=byte(0x2F);
=byte(0x30);
=byte(0x31);
=byte(0x32);
=byte(0x33);
=byte(0x34);
=byte(0x35);
=byte(0x36);
=byte(0x37);

=byte(0x38);

=byte(0x3A);
=byte(0x3B);
=byte(0x3C);
=byte(0x3D);
=byte(0x3E);
=byte(0x3F);
=byte(0x40);
(

=byte(0x45);

=byte(0x4D);

https://learn.adafruit.com/introducing-bluefruit-ez-key-diy-bluetooth-
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=byte(0x39);

=byte(0x46);
=byte(0x47);
=byte(0x48);
=byte(0x49);
=byte(0x4A);
=byte(0x4B);
=byte(0x4C);

=byte(0x4E);
=byte(0x4F);
=byte(0x50);
=byte(0x51);
=byte(0x52);
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final byte KEY_NUM_LOCK =byte(0x53);

final byte KEY_KEYPAD_DIVIDE =byte(0x54);
final byte KEY_KEYPAD_MULTIPLY =byte(0x55);
final byte KEY_KEYPAD_SUBTRACT =byte(0x56);

final byte KEY_KEYPAD_ADD =byte(0x57);
final byte KEY_KEYPAD_ENTER =byte(0x58);
final byte KEY_KEYPAD _1 —byte(0x59)'
final byte KEY_KEYPAD_2 =byte(0x5A);
final byte KEY_KEYPAD_3 =byte(0x5B);
final byte KEY_KEYPAD 4 =byte(0x5C);
final byte KEY_KEYPAD_5 =byte(0x5D);
final byte KEY_KEYPAD_6 =byte(0x5E);
final byte KEY_KEYPAD 7 =byte(0x5F);
final byte KEY_KEYPAD_8 =byte(0x60);
final byte KEY_KEYPAD_9 =byte(0x61);
final byte KEY_KEYPAD_0 =byte(0x62);
final byte KEY_KEYPAD_DECIMAL  =byte(0x63);
final byte KEY_EUROPE_2 =byte(0x64);
final byte KEY_APPLICATION =byte(0x65);
final byte KEY_POWER =byte(0x66);

final byte KEY_KEYPAD_EQUAL =byte(0x67);
final byte KEY_F13 =byte(0x68);

final byte KEY_F14 =byte(0x69);

final byte KEY_F15 =byte(0x6A);

final byte KEY_CONTROL_LEFT =byte(0xEO0);
final byte KEY_SHIFT_LEFT =byte(0xE1);
final byte KEY_ALT_LEFT =byte(0xE2);
final byte KEY_GUI_LEFT =byte(0xE3);

final byte KEY_CONTROL_RIGHT  =byte(0xE4);
final byte KEY_SHIFT_RIGHT =byte(OxE5);
final byte KEY_ALT_RIGHT =byte(OxE6);
final byte KEY_GUI_RIGHT =byte(0xE7);

Here is the Arduino function we use to send a raw keyCommand. For example, if you want
to send the keystroke for the letter 'a' (no shift) you'll want to call

keyCommand(0, 4);

to press the keycode 4 ('a’) followed by a release
keyCommand(0, 0);

if you want to send the keystroke for SHIFT 'a' you'll want to call
keyCommand(MODIFIER_SHIFT_LEFT, 4);

if you want to send the keystroke for CTRL-SHIFT 'a' you'll want to call

keyCommand(MODIFIER_SHIFT_LEFT | MODIFIER_CONTROL_LEFT, 4);
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You can also send multiple keystrokes (‘chords'). If you want to press 'a' and 'b' at the same
time, send

keyCommand(0, 4, 5);

for keycodes 4 and 5 at the same time. You can send up to 6 consecutive keys at once,
don't forget to send the release 'key up' command or the key will be 'stuck'!

void keyCommand(uint8_t modifiers, uint8_t keycode1, uint8_t keycode2 = 0, uint8_t keycode3 = 0,
uint8_t keycode4 = 0, uint8_t keycode5 = 0, uint8_t keycode6 = 0) {
BT.write(OxFD); /[ our command
BT.write(modifiers); // modifier!
BT.write((byte)0x00); // 0x00
BT.write(keycode1); // key code #1
BT.write(keycode2); // key code #2
BT.write(keycode3); // key code #3
BT.write(keycoded4); // key code #4
BT.write(keycodeb); // key code #5
BT.write(keycode6); // key code #6

Raw HID Mouse Reports

As of v1.1 (shipping Oct 22, 2013) Bluefruit can also send raw HID Mouse reports. This
allows moving and clicking a virtual mouse! Mouse reports are relative movement. So you
can send 'go left 4 units' but you cant send 'go to absolute location x, y'

Raw HID reports start with 0xFD and have 8 bytes following. For mouse, its
O0xFD 0x00 0x03 [buttons] [left/right] [up/down] 0x0 0x0 0x0

For buttons, its a bitmask, left button (button 0) is0x01 right button (button 1) is0x02, etc
so that button n is (1 << n) you can | these together

up/down/left/right are again, relative movements. You can move up to +127 up/left to -127
down/right units at a time.

void mouseCommand(uint8_t buttons, uint8_t x, uint8_t y) {
BT.write(0xFD);

BT.write((byte)0x00);

BT.write((byte)0x03);

BT.write(buttons);

BT.write(x);
BT.write(y);
BT.write((byte)0x00);
BT.write((byte)0x00);
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BT.write((byte)0x00);
1

For example if we wanted to click the left button and drag the mouse down 50 units send

mouseCommand(0x1, 0, -50);

Raw HID Consumer Reports

As of v1.2, Bluefruit can send raw HID consumer reports. There are "Home",

"KeyboardLayout", "Search", "Snapshot", "VolumeUp", "VolumeDown", "Play/Pause", "Fast
Forward", "Rewind","Scan Next Track", "Scan Previous Track", "Random Play","Stop" keys

you can use with a 2 bytes bitmask.

Raw HID consumer report start withOxFD and have 8 bytes following. For consumer keys,

its
0xFD 0x00 0x02 [bitmask] [bitmask] 0x0 0x0 0x0 0x0

"Home" is bit 0, the bitmask is 0x01 0x00
"Stop" is bit 12, the bitmask is 0x00 0x10

You can | these together like mouse report

void consumerCommand(uint8_t maskO0,uint8_t mask1) {
BT.write(0xFD);
BT.write((byte)0x00);
BT.write((byte)0x02);
BT.write(maskO0);
BT.write(mask1);
BT.write((byte)0x00);
BT.write((byte)0x00);
BT.write((byte)0x00);
BT.write((byte)0x00);
}

—_ — — —

For example if we wanted to click the Play/Pause
consumerCommand(0x40,0x00);
Then release it

consumerCommand(0x00,0x00);

Adafruit | i
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Testing Sketch (Arduino)

We use this code to generate/test the various UART-sendable characters, you can use it for
reference to control via an Arduino or other microcontroller. Remember that some of these
non-printing characters can really confuse your computer so use with care!

/I Adafruit test code for Bluefruit EZ-Key serial reports

// Uncomment tests as you wish, remember that this will

// send various keypresses to your computer which may really

/[ annoy it! We used

/I http://www.cambiaresearch.com/articles/15/javascript-char-codes-key-codes
// to test the non-printing characters!

/I Connect the RX pin on the EZ-Key to digital #2 on the UNO

#include <SoftwareSerial.h>
SoftwareSerial BT = SoftwareSerial(3, 2);

void printabletest() {
Serial.printin("Testing printable 0x20-0x7E...");
for (char ¢ = 0x20; ¢ <= OX7E; c++) {
Serial.write(c);
BT.write(c);
delay(10);
}

BT.write(\n');

delay(3000);

Serial.read(); // eat one char
Serial.printin();

for (uint16_t i=0; i<200; i++) {
while (Serial.available())
Serial.write(Serial.read());
delay(10);
}
}

void nonprinting() {

Serial.printin("Insert");
BT.write(1); delay(1000);
Serial.printin("Home");
BT.write(2); delay(1000);
Serial.printin("Page Up");
BT.write(3); delay(1000);
Serial.printin("Delete");
BT.write(4); delay(1000);
Serial.printin("End");
BT.write(5); delay(1000);
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Serial.printin("Page Down");
BT.write(6); delay(1000);
Serial.printin("Right Arrow");
BT.write(7); delay(1000);
Serial.printin("Backspace");
BT.write(8); delay(1000);
Serial.printin("Tab");
BT.write(9); delay(1000);
Serial.printin("Enter");
BT.write(10); delay(1000);
Serial.printin("Left Arrow");
BT.write(11); delay(1000);
Serial.printin("Down Arrow");
BT.write(12); delay(1000);
Serial.printin("Enter");
BT.write(13); delay(1000);
Serial.printin("Up Arrow");
BT.write(14); delay(1000);

for (uint8_t i=15; i<27; i++) {
Serial.print("F"); Serial.printin(i-14, DEC);
BT.write(i); delay(500);
}
Serial.printin("ESC");
BT.write(27); delay(1000);
Serial.printin("Capslock");
BT.write(28); delay(1000);
Serial.printin("Scroll lock");
BT.write(29); delay(1000);
Serial.printin("Break");
BT.write(30); delay(1000);
Serial.printin("Numlock™);
BT.write(31); delay(500);

1
void altkeystest() {

Serial.printin("Left Control\n");
BT.write(0xEQ);

delay(500);

Serial.printin("Left Shift\n");
BT.write(OXE1);

delay(500);

Serial.printin("Left Alt\n");
BT.write(0XE2);

delay(500);

Serial.printin("Left GUNn");
BT.write(0xE3);

delay(500);
Serial.printin("Right Control\n");
BT.write(0xE4);

delay(500);
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Serial.printin("Right Shift\n");
BT.write(0XE5);
delay(500);
Serial.printin("Right Alt\n");
BT.write(0XE6);
delay(500);
Serial.printin("Right GUNn");
BT.write(0xE7);
delay(500);

}

void iphonekeyboard() {
while (1) {
Serial.printin("toggle keyboard");
BT.write(0x7F);
delay(1000);
}
}

void keyCommand(uint8_t modifiers, uint8_t keycode1, uint8_t keycode2 = 0, uint8_t keycode3 = 0,

uint8_t keycode4 = 0, uint8_t keycode5 = 0, uint8_t keycode6 = 0) {

BT.write(0xFD); // our command
BT.write(modifiers); // modifier!
BT.write((byte)0x00); // 0x00
BT.write(keycode1); // key code #1
BT.write(keycode?2); // key code #2
BT.write(keycode3); // key code #3
BT.write(keycode4); // key code #4
BT.write(keycodeb); // key code #5
BT.write(keycode6); // key code #6

}

void rawkeytest() {
/I test sending a single 'a’ (keycode 4)
keyCommand(0, 4);
delay(100);
keyCommand(0, 0);
}

[rexeeeeeeesss Support added in v1.1 ¥/

void rawmousetest() {
Serial.printin("Move mouse!");
Serial.printin("Right");
mouseCommand(0, -100, 0);
delay(200);
Serial.printin("Down");
mouseCommand(0, 0, -100);
delay(200);
Serial.printin("Left");
mouseCommand(0, 100, 0);

© Adafruit Industries
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}

delay(200);
Serial.printin("Up");

mouseCommand(0, 0, 100);

delay(200);

void mouseCommand(uint8_t buttons, uint8_t x, uint8_t y) {

}

BT.write(0xFD);

BT.write((byte)0x00);
BT.write((byte)0x03);

(

(
BT.write(buttons);
BT.write(x);
BT.write(y);

(

(

(

BT.write((byte)0x00);
BT.write((byte)0x00);
BT.write((byte)0x00);

[reeeeeeeessss Support added in v1.1 ¥/

void setup() {

}

Serial.begin(9600);
BT.begin(9600);

Serial.printin("Softserial/BT test\n\rPress any key+return to start");
while (! Serial.available());

printabletest(); delay(200);

/laltkeystest();
//monprinting();
/liphonekeyboard();
/Irawkeytest();

//Supported in v1.1
//rawmousetest();

void loop() {

}

© Adafruit Industries
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Remapping the Buttons (Serial)

If you have a Bluefruit v1.1 or later, you can wirelessly re-map the keys, no need to use a
console cable (altho the console cable technique will still work). Original v1.0 Bluefruits can
only be remapped over serial console

The default buttons->keypresses will be satisfactory for most projects. However, you may
want to customize those keys so when a GPIO pin is pulled to ground, a different keystroke
is sent. It isn't that difficult to do! However, you will need an ETDI

Friend (http://adafru.it/284) or USB console cable (http://adafru.it/954) to connect the EZ-
Key to your computer.
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= P e e el PR I B T I
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To USB
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[ - e— LR S B O T O I I O O O T
- R T T O T
_.lpq - - . - e " "W - e 8 B @ - -
O & . . w " "W .. .

If using an FTDI friend, connect the TX pin of the EZ-Key to the RX pin on your FTDI friend
and the RX pin to the TX pin (receiver goes to transmit). Also be sure to power the EZ-Key.
You do not have to pair it for this remapping

You will have to put the EZ-Key into re-mapping mode. To do this, the pair-button must be
pressed while the module is powered up. The easiest way to do this is to disconnect the
red Vin wire from the console cable, press down on the button, then plug in the red wire,
that's it!

As a 'safety' procedure, every time you power the module with the re-pair button pressed
(to enter remapping mode) it will reload the default keymap. This is so if you somehow
really mess things up, you can always get back to the default keymap without a console
cable
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Load Processing Sketch

We wrote the re-mapping software in Processing.Processing is cross-platform and easy to
install (http://adafru.it/kA6). Please download Processing v1.5.1 (http://adafru.it/cK1) since
that's known to work

You'll also need to download and install the ControlP5 library

Click to download the ControlP5 library
http://adafru.it/djs

Then click below to download the remap software

EZ-Key Remapper.zip

http://adafru.it/cK2

Uncompress and open the remapper.pde in Processing. Plug in the USB console cable or
FTDI adapter. Select Sketch->Run menu item and look in the debug window below, you
should see Found Serial Ports: and then a list of ports. On Windows, it will be something
like COM1, COM2, COMS3 etc. On Mac/Linux it will be something like/dev/USBtty or
/dev/cu.usbserial

https://learn.adafruit.com/introducing-bluefruit-ez-key-diy-bluetooth-
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file:///download/?processing
https://processing.org/download/?processing
http://www.sojamo.de/libraries/controlP5/
http://learn.adafruit.com/system/assets/assets/000/011/306/original/EZ-Key_Remapper.zip?1380305964

processing_remap | Processing 1.5.1 pe| E
File Edit Sketeh Took Help

00 BEBHAO

procassing_remap | hid_kays |

hid keys.zet_key reporc(ll, MODIFIER NOME, KEY §, KEY NONE, HEY NONE, KEY MONE, HEY WONE, KEY WONE]: -
hid_keys.sec key report(ll, MODIFIER NOME, KEY D, EEY NONE, EEY WONE, KEY NONE, EEY _HONE, FEY NONE]:

oucput=hid keys.gensrate output(]: “

printlnfoutpuat) ;

printlnihid keys.output.length)):

printin{”Found Serial ports: ");
printin{Serial.lisc()); |
nyPort = new Serial(thi=, "COM3"™, 9600):
nyForc.buffeclntil('n'):

1]

roid deamr]) |

L] m L

ke I—
Copy and paste the list into a notepad, now File->Run it again, this time with the USB

console cable unplugged. The list should be one line shorter. In this case COMS3 is missing.
That means that the cable name is COM3
in the line

myPort = new Serial(this, "COM3", 9600);

Change "COM3" to whatever the cable name is. Again, for Mac or Linux it will probably be
/dev/cu.something

Replug in the FTDI/Console cable.
Select File->Run again to start the script with the correct /dev or COM port

Now disconnect the red wire that is powering the EZ-Key, press and hold the Pair button on
the module and reconnect the red wire. You should see:
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Adafruit Bluefruit HID 9/18/2013

Remap ready!

Appear in the bottom half of the screen. Now click that large gray square window to remap

processing_f... El_léJ

You should see

OK

Set Mapping:128

Indicating that the mapping was sent.
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[ [ processing_remap | Processing 1.5.1 JTE-—_—_ - O = - o] & e

File Edit Sketeh Took Help

00 BEED

procassing_remap |

hld_keys.set_hey;tepnrt[lu, MODIFIER MOME, KEY &, KEY NONE, EEY WONE, EEY NONE, FEY NONE, FEY NONE):
hid_keys.sec key report(ll, MODIFIER NOME, KEY D, EEY NONE, EEY WONE, KEY NONE, EEY _HONE, FEY NONE]:

H oucput=hid keys.gensrate output(]: “

printlnfoutpuat) ;

printininlid Heys. oucpuat, Lengonl )2

printin{”Found Serial ports: ");
printini{Serial.lisc(h}: ‘
myPort = new Serial(thi=, "COM3"™, 9500):
nyForc.buffeclUntil('n'):

i

vold drease]) |

Customizing Keys

OK now you want to actually change the key report. Each of the 12 keys has a report. This
is an example for #0:

hid_keys.set_key_report(0, MODIFIER_NONE, KEY_A, KEY_NONE, KEY_NONE,
KEY_NONE, KEY_NONE, KEY_NONE);

There are 8 'arguments' to each report:
The first one is the GPIO#, in this case its#0.
Second is the modifier keys, such as Shift, Control, Alt, etc. Seehid_keys.pde for a list of

the modifier available. You can 'or' the modifiers. For example, if you want to press shift and
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control modifiers at the same time, use MODIFIER_SHIFT_LEFT |
MODIFIER_CONTROL_LEFT

The last 6 are the 6 slots available for concurrent keys. You can have up to 6 key-codes
sent at once (handy for when you want to send complex key reports. Check hid_keys.pde
for the list of all the keycodes!

https://learn.adafruit.com/introducing-bluefruit-ez-key-diy-bluetooth-

Adafruit | i
© Adafruit Industries hid-keyboard

Page 52 of 60



Remapping the Buttons (Wireless)

The default buttons->keypresses will be satisfactory for most projects. However, you may
want to customize those keys so when a GPIO pin is pulled to ground, a different keystroke
is sent. It isn't that difficult to do!

Bluefruit v1.1 (Oct 22, 2013 or later) supports over-the-air key remappingand also you
can map the pins to mouse movement or mouse clicks

Bluefruit v1.2 (Nov 7 2013 or later) - We have added support for mapping buttons to some
"Consumer Report" keys, also known as Multimedia buttons. You can use the graphical
remapper for the consumer keys.

Over-the-air remapping is suggested since there's no wiring required and you can do it at
any time. You just need to make sure the Bluefruit is paired to your computer. It's been
tested on Mac and Windows but should also work on Linux.

You'll need to install Processing v1.5.1 to run the remapper. (http://adafru.it/cK1)We
suggest 1.5.1, 2.0+ may not work. If v1.5 is giving you problems, though, try v2!

You will also need to download and install the ControlP5 library:

In Windows, you should use the 32-bit version of Processing!
Download the ControlP5 Llbrary
http://adafru.it/djs

Then download the zip with the wireless remapper code

GUI EZ-Key Remapper 12/20/2013

http://adafru.it/d2B

Uncompress and open the GUI_EZKey remapper.pde in Processing.

Make sure the Bluefruit is paired to your computer, since we need to be paired in order to
send it the new keycodes

Select Sketch -> Run or click the play button to start the graphical remapper

You can now select the pins and then using the menus below select what
mouse/keyboard/consumer reports you want. Mouse reports can be X movement, Y
movement, wheel, and three different buttons in any combination. Keyboard reports can be
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https://processing.org/download/?processing
http://www.sojamo.de/libraries/controlP5/
http://learn.adafruit.com/system/assets/assets/000/013/042/original/GUI_EZKey_remapper_12-20-13.zip?1387568625

up to 6 keystroke commands, with modifiers, ascii-type, non-printing, etc. Consumer reports
are special commands, such as volume up, volume down, iPhone keyboard display/hide
and cannot be mixed or combined unlike mouse & Keyboard.

You can also save and load your keymap which is handy for trying out different mappings!
If you get the error "the function setindex(int) does not exist", try using Processing version
2.2.1 and ControlP5 version 2.0.4

[ GUIEZKey_remapper =

Clisk key ping to remap

1@ @ =1
S0 @ ricar
il @ 2
'@ g
@ B
b8 &= crace
5@ B sPACERETURN
“. -L-::frl Lalt Horne

3. B WalumeUp
E'. B Play/Pause
1. YolurmeDawn

o
1
EEYEBORRD- A-0

000000

AOO_KEY CLEAR_KEY
DEFAULT_MAP  LOAD_HAP SAVE_HAP SEHD_MAPF Key D added

o

When you're done, click SEND_MAP to send it to your Bluefruit. In the main Processing
window you should see the text report indicate that it found a Bluefruit and also that it sent
data with a Checksum Match

"Text style"” over-the-air remapper

The original remapper is a Processing sketch that requires editing the reports by hand.
While this is the most powerful, most people may be happier with the graphical remapper
above. Still, for more advanced users, you can edit the reports per button with more
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flexibility here.

HID_EZKey_remapper.zip

http://adafru.it/cQX

Uncompress and open the HID_EZKey_remapper.pde in Processing.

Make sure the Bluefruit is paired to your computer, since we need to be paired in order to
send it the new keycodes

Select Sketch -> Run or click the play button

You should see the text report indicate that it found a Bluefruit and also that it sent data with
a Checksum Match

https://learn.adafruit.com/introducing-bluefruit-ez-key-diy-bluetooth-
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http://learn.adafruit.com/system/assets/assets/000/011/817/original/HID_EZKey_remapper.zip?1382476709

F A |

HID_E7Key_remapper | Processing 1.5.1 = | ]

File Edit Sketch Tools Help

00 BBEAG

HID_EZKey_ramapper + |

[
Hid_key= hid_keys= Hid_keys():

hid keys.zet key report(0, MODIFIER NONE, FEY ARROW UP, KEY NONE, EEY NONE, FEY NONE, KEY NONE, EEY NONE);
hid_keys.ser_key peport(l, MODIFIER _NOWE, EEY_ARROW_DOWN, KEY NONE, KEY NONE, KEY_NONE, KEY NONE, KEY WONE) :
hid_keys.set key report(2, MODIFIER_NONE, FEY ARROW_LEFT, EEY WONE, FEY _NONE, ¥EY NOME, EEY NONE, FEY NONE):
hid keys.set key report(3, MODIFIER NONE, FEY ARROW RIGHT, FEY NONE, KEY NOME, KEY NONE, KEY NONE, KEY NONE):

hid_keys.set_key report(d, MODIFIER_NONE, FEY RETURN, KEY _NONE, EEY NONE, FEY_NONE, KEY NONE, EEY_NONE)
hid_keys.set key report(5, MODIFIER_NONE, FEY _SPACE, FEY _NONE, FEY NONWE, KEY_NONE, FEY _NONE, FEY NONE):
hid_keys.set_key_reporc(6, MODIFIER_NONE, FEY_l, EEY NONE, KEY _NONE, KEY NONE, KEY NONE, KEY NONE):
hid _keys.set_key reporc(7, MODIFIER_WONE, FEY 2, KEY NONE, FEY NONE, FEY WONE, KEY NONE, FEY NONE):

hid_keys.set_key_report(6, MODIFIER_NONE, FEY W, KEY NONE, KEY_NONE, KEY NONE, KEY NONE, KEY_NONE): =z
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HID_E7Key_remapper | Processing 1.5.1 | ] [

File Edit Sketch Tools Help

(P l=goje]s]s

HID_EZK=&y_remapper . . . -

1 =etup () |

Hid_keys hid _keys=new Hid_keys():

hid keys.set key reporc(0, MODIFIER NONE, FEY ARROW UP, KEY NONE, EEY NONE, FEY NONE, FEY NONE, EEY NONE);

keys.sec_key reporc(l, MODIFIER_NONE, KEY ARROV_DOWN, KEY WONE, FEY_NONE, KEY WOME, BEY NONE, KEY_NONE):
d_keys.set key report{2, MODIFIER _NONE, FEY ARROU LEFT, KEY NONE, KEY NONE, KEY NONE, EEY NONE, FEY NONE):

hid keys.set key report(3, MODIFIER NONE, FEY ARROW RIGHT, KEY NONE, KEY NONE, KEY NONE, KEY NONE, KEY NONE):

hid_keys.ser_key report(d, MODIFIER_NONE, FEY RETURN, KEY NONE, EEY NONE, FEY NONE, KEY NONE, EEY NONE)
hid_kevs.set key report(5, MODIFIER_NONE, FEY _SPACE, FEY _NONE, FEY NWONE, KEY NONE, FEY _NONE, FEY NONE):
hid_keys.set_key_reporc(6, MODIFIER_NONE, FEY_l, FEY NONE, KEY _NONE, KEY NONE, KEY NONE, KEY NONE):
hid_keys.set_key reporc(7, MODIFIER_NWONE, KEY 2, KEY NONE, FEY NONE, FEY HONE, KEY NONE, FEY NONE):

hid_keys,set_key_report(E, MODIFIER_NWONE, FEV W, KEY NONE, FEY NONE, KEY_NONE, FEY_NONE, FEY_WOME) : i

That's it, you can use it immediately with the new keymap!
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FAQ

What is the current draw for Bluefruit?
Bluefruit requires ~3VDC, there's an onboard regulator for providing nice clean power. It
draws 25mA at all times while paired and an extra 2mA on average during transmission

When the module is in Reset mode (Reset tied low) it draws 2-3mA quiescent.

What is the latency ("fly time") for the 12 GPIO buttons?

For Bluefruit v1.0, latency is about 100-120ms. For v1.1 and later (October 22, 2013)
latency is 25-35ms. There is some 'jitter' in the latency but we find its not that noticeable.
Is it possible to firmware update Bluefruits?

There is no way to re-program or update Bluefruit modules internal firmware - the key
remapping is changing the EEPROM data, not the program storage.

How come the EZ-Key can be sluggish on Android?

There's some issues with Android 4.1 thru 4.4 that cause Bluetooth to act odd due to WiFi
interference. Try turning off WiFi to see if that helps. [check this post for

details! (http:/adafru.it/djF)]
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https://forums.adafruit.com/viewtopic.php?f=22&t=53205&p=269547#p269547

Downloads

Files

o Fritzing object in Adafruit Fritzing library (http://adafru.it/c7M)
o EagleCAD PCB files on GitHub (http://adafru.it/rAu)

Schematic
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Fabrication Print
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https://github.com/adafruit/Fritzing-Library/
https://github.com/adafruit/Adafruit-Bluefruit-EZ-Key-PCB
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